The performance your server delivers depends not only on its processor but also on the drive technologies it uses. In Principled Technologies’ tests in our labs, we explored storage options for a Dell PowerEdge R720 server with the Dell PERC H710P controller running business applications in virtual machines (VM), including an all hard disk drive (HDD) configuration, a solution featuring CacheCade technology, and a hybrid solution that uses both HDDs and solid-state drives (SSDs) with Cut Through I/O (CTIO) technology enabled. CTIO boosts transactional I/O performance of SSDs configured as virtual disk volumes.

The Dell PowerEdge R720 comes with the PERC H710P RAID controller, which was designed with a fast dual-core 800 MHz RAID-on-chip (ROC) processor and 1 GB DDR3 cache that boosts I/O performance compared to the previous generation.

Using the PERC H710P with CacheCade technology, which accelerates I/O performance of existing HDDs using SSDs as high-performance read cache, delivered 127.5 percent greater throughput and supported 2.5 times the number of users than the HDD-only configuration. Upgrading the Dell PowerEdge R720 with a combination of hard drives and solid-state drives delivered a whopping 610.9 percent greater throughput than the HDD configuration and supported 6.5 times the number of users. The new Dell PowerEdge R720 allows you the drive configuration options to deliver excellent performance and support the number of users you need.
CHOOSE THE STORAGE SOLUTION THAT MEETS YOUR NEEDS

When you are investing in a new server, it’s important to configure the storage component to meet your company’s needs. The Dell PowerEdge R720 server can hold 16 drives, twice that of its previous generation counterpart, and is available with a range of drive configurations that deliver varying levels of throughput and support varying numbers of users.

We tested the performance of a Dell PowerEdge R720 server by running multiple business applications simultaneously in VMs using the following drive configurations to handle the data volumes. Please note that each configuration had two additional drives that ran the operating systems for each business application VM.

- Six SAS hard disk drives (HDD solution)
- Six SAS hard disk drives with two solid-state drives in a CacheCade pool (CacheCade solution)
- Eight SAS hard disk drives and four solid-state drives optimized with CTIO technology (Hybrid solution)

Our goal was to measure the performance of a Dell PowerEdge R720 server running mixed workloads, and the increase in throughput and user count the above storage configurations can deliver. To do so, we set up each solution to run three business applications—Microsoft® Exchange® for email, Microsoft SharePoint® for collaboration, and Microsoft SQL Server® for database—each in its own virtual machine. Then, as the solutions simultaneously ran these applications, we used benchmark software to quantify the throughput and user count that each solution supported.

As Figure 1 shows, adding SSDs as a CacheCade volume increased the supported number of users over the HDD solution by an average of 151.6 percent, and adding SSDs for the Hybrid solution increased the supported number of users over the HDD solution by an average of 550.7 percent. Each user is running one of the three business applications.

Figure 1: The Dell PowerEdge R720 scales to meet your needs. In our tests, the PowerEdge R720 supported from 1,164 to 7,574 total users using varying drive configurations.
THE RIGHT TOOL FOR THE JOB

We used three different benchmarks to assess database, mail, and collaboration performance: Benchmark Factory, Microsoft Load Generator 2010, and WSSDW 1.0.0.0 Beta respectively. To determine the maximum number of users supported by each configuration in our tests, we used a Microsoft Exchange latency counter as a threshold and reduced the users (and subsequently, the workload) for each configuration until it was consistently below this latency threshold. We simulated the same number of SharePoint users as we did Exchange users, and scaled SQL Server users proportionately.

Database testing

To measure database performance, we used the Benchmark Factory for Databases tool, which lets you conduct database workload replay, industry-standard benchmark testing, and scalability testing. It enables you to deploy changes to your database environment with confidence by reducing the risks associated with patches, upgrades, migrations, and adjustments to virtual machine configurations. With this workload replay and scheduling software, you can eliminate slow SQL database performance and dramatically simplify high-performance database management. We used an On-Line Transaction Processing (OLTP) database test in Benchmark Factory and determined that a heavy database user would generate 20 database transactions per minute. We used a think time of 10 milliseconds in between each transaction and throttled back the workload proportionately to the Exchange workload.

More information on Benchmark Factory is available at http://www.quest.com/benchmark-factory/.

Mail testing

To test the solutions’ mail server performance, we used the Microsoft Load Generator 2010 (LoadGen) benchmark, performing tasks to simulate a heavy user generating mail activity. We used the I/O database reads average latency counter to determine the maximum number of users each configuration could support, beginning with a user count that exceeded the latency threshold of 20ms average and then dropping the user count by multiples of 100 users until the latency remained consistently below 20ms. We determined that the HDD solution could support 300 users, the CacheCade solution could support 700 users, and the Hybrid solution could support 2,500 users. For our workloads, we used the following settings:

- Mailbox Profile: 100MB mailboxes
- Action Profile: Very heavy
- Client Type: Outlook 2007 Cached
Collaboration testing

To simulate the traffic of SharePoint Server 2010 users, we used the WSSDW 1.0.0.0 Beta test. This test creates sample data, populates the server with it, and simulates SharePoint Server users completing everyday tasks.

We used Visual Studio 2010 to execute the test workload, generating a realistic user workload where each of the simulated heavy users performed a task every minute. To do this, we set up the test to run 15, 35, and 125 Visual Studio virtual users with a 3-second think time in between each of the various tasks for the HDD solution, CacheCade solution, and Hybrid solution, respectively. The virtual user count here was set to match the Exchange user count. The test workload then reports throughput in tests per second.

For more details about SharePoint Server, see http://office.microsoft.com/en-us/sharepoint-server-help/.

WHAT WE FOUND

In our testing, we used the response time, or latency, in Microsoft Exchange Server 2010, to determine how many users each drive configuration could support. A short response time is an important measure of performance—it means that the users need to wait less time for the server to complete a task. Figure 2 shows the average response time (I/O database reads average latency), in milliseconds, for the drive configurations while under test.

<table>
<thead>
<tr>
<th>Drive Configuration</th>
<th>Response time (ms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDD solution</td>
<td>19.1</td>
</tr>
<tr>
<td>CacheCade solution</td>
<td>17.1</td>
</tr>
<tr>
<td>Hybrid solution</td>
<td>15.1</td>
</tr>
</tbody>
</table>

Figure 2: Median latency for the three drive solutions.

Figure 3 shows the average throughput each of the solutions delivered. We conducted three test runs and present the results from the median run. As Figure 3 shows, adding SSDs as a CacheCade volume increased the overall throughput over the HDD solution by an average of 127.5 percent, and adding SSDs for the Hybrid solution increased the overall throughput over the HDD solution by an average of 610.9 percent.
Throughput comparison: Dell PowerEdge R720 drive options

<table>
<thead>
<tr>
<th></th>
<th>SQL Server transactions per second</th>
<th>Exchange Server operations per second</th>
<th>SharePoint Server tasks per second</th>
<th>Average percentage increase over HDD solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDD solution</td>
<td>188.2</td>
<td>302.0</td>
<td>4.8</td>
<td></td>
</tr>
<tr>
<td>CacheCade solution</td>
<td>509.9</td>
<td>555.6</td>
<td>11.2</td>
<td>127.5%</td>
</tr>
<tr>
<td>Hybrid solution</td>
<td>858.1</td>
<td>2,556.1</td>
<td>40.1</td>
<td>610.9%</td>
</tr>
</tbody>
</table>

Figure 3: Median throughput for the three applications running on the three drive solutions.

Figure 4 shows the number of users each solution supported while delivering an acceptable Exchange latency averaging less than 20ms for end users. The number of SQL Server users supported, in this case, is determined by assuming that a very heavy user would generate 20 SQL Server transactions per minute.

<table>
<thead>
<tr>
<th></th>
<th>Number of SQL Server users</th>
<th>Number of Exchange users</th>
<th>Number of SharePoint users</th>
<th>Total number of users</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDD solution</td>
<td>564</td>
<td>300</td>
<td>300</td>
<td>1,164</td>
</tr>
<tr>
<td>CacheCade solution</td>
<td>1,529</td>
<td>700</td>
<td>700</td>
<td>2,929</td>
</tr>
<tr>
<td>Hybrid solution</td>
<td>2,574</td>
<td>2,500</td>
<td>2,500</td>
<td>7,574</td>
</tr>
</tbody>
</table>

Figure 4: Number of users the three drive solutions supported.

**IN CONCLUSION**

The new Dell PowerEdge R720 comes with more than just the power to handle your heavy mixed workloads – it offers many storage solutions to deliver the level of performance you need. In our tests, we found that that a configuration of all HDDs could support a total of 1,164 users accessing database, mail, and collaboration applications. The Dell PowerEdge R720 solution with CacheCade enabled increased the supported number of users to 2,929, an increase of 151.6 percent. Finally, the Hybrid solution increased the number of users to 7,574, or an increase of 550.7 percent over the HDD solution, providing you with numerous options and scalability to get the performance you need.
## APPENDIX A – SERVER CONFIGURATION INFORMATION

Figure 5 provides detailed configuration information about the test server.

<table>
<thead>
<tr>
<th>System</th>
<th>Dell PowerEdge R720</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Number of processor packages</td>
<td>2</td>
</tr>
<tr>
<td>Number of cores per processor package</td>
<td>8</td>
</tr>
<tr>
<td>Number of hardware threads per core</td>
<td>2</td>
</tr>
<tr>
<td>System power management policy</td>
<td>Balanced</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel®</td>
</tr>
<tr>
<td>Name</td>
<td>Xeon®</td>
</tr>
<tr>
<td>Model number</td>
<td>E5-2680</td>
</tr>
<tr>
<td>Stepping</td>
<td>C1</td>
</tr>
<tr>
<td>Socket type</td>
<td>LGA2011</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>2.70</td>
</tr>
<tr>
<td>Bus frequency (GT/s)</td>
<td>8.0</td>
</tr>
<tr>
<td>L1 cache</td>
<td>32 KB + 32 KB (per core)</td>
</tr>
<tr>
<td>L2 cache</td>
<td>256 KB (per core)</td>
</tr>
<tr>
<td>L3 cache (MB)</td>
<td>20</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Dell PowerEdge R720</td>
</tr>
<tr>
<td>Motherboard model number</td>
<td>00W9X3</td>
</tr>
<tr>
<td>Motherboard chipset</td>
<td>Intel C600</td>
</tr>
<tr>
<td>BIOS name and version</td>
<td>Dell 0.3.38</td>
</tr>
<tr>
<td>BIOS settings</td>
<td>System profile set to Performance, Memory set to Optimizer mode</td>
</tr>
<tr>
<td><strong>Memory module(s)</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Hynix HMT31GR7BFR4A-H9</td>
</tr>
<tr>
<td>Type</td>
<td>PC3L-10600R</td>
</tr>
<tr>
<td>Speed (MHz)</td>
<td>1,333</td>
</tr>
<tr>
<td>Speed in the system currently running @ (MHz)</td>
<td>1,333</td>
</tr>
<tr>
<td>Timing/Latency (tCL-tRCD-tRP-tRASmin)</td>
<td>9-9-9-36</td>
</tr>
<tr>
<td>RAM module size (GB)</td>
<td>8</td>
</tr>
<tr>
<td>Number of RAM modules</td>
<td>8</td>
</tr>
<tr>
<td>Chip organization</td>
<td>Double-sided</td>
</tr>
<tr>
<td>Total system memory (GB)</td>
<td>64</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>VMware® ESXi 5.0.0</td>
</tr>
<tr>
<td>Build number</td>
<td>515841</td>
</tr>
<tr>
<td>File system</td>
<td>EXT3</td>
</tr>
<tr>
<td>Kernel</td>
<td>5.0.0</td>
</tr>
<tr>
<td>System</td>
<td>Dell PowerEdge R720</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
</tr>
<tr>
<td><strong>Network card/subsystem</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel I350 Quad Port Gigabit Network Daughter Card</td>
</tr>
<tr>
<td>Type</td>
<td>Integrated</td>
</tr>
<tr>
<td><strong>Optical drive</strong></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>TEAC DV-28SW</td>
</tr>
<tr>
<td><strong>USB ports</strong></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>4 external, 1 internal</td>
</tr>
<tr>
<td>Type</td>
<td>2.0</td>
</tr>
<tr>
<td><strong>Power supplies</strong></td>
<td></td>
</tr>
<tr>
<td>Total number</td>
<td>2</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Dell E1100E-S0</td>
</tr>
<tr>
<td>Wattage of each (W)</td>
<td>1,100</td>
</tr>
<tr>
<td><strong>Cooling fans</strong></td>
<td></td>
</tr>
<tr>
<td>Total number</td>
<td>6</td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>AVC DBTC0638B2V</td>
</tr>
<tr>
<td>Dimensions (h x w) of each</td>
<td>2-1/2” x 2-1/2”</td>
</tr>
<tr>
<td>Volts</td>
<td>12</td>
</tr>
<tr>
<td>Amps</td>
<td>1.20</td>
</tr>
</tbody>
</table>

*Figure 5: Detailed information for the test server.*
# APPENDIX B – TEST STORAGE INFORMATION

Figure 6 provides detailed information for the test storage.

<table>
<thead>
<tr>
<th>RAID controller</th>
<th>Dell PERC H710P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firmware version</td>
<td>21.0.1-132 A01</td>
</tr>
<tr>
<td>Driver version</td>
<td>5.34</td>
</tr>
<tr>
<td>Cache size (MB)</td>
<td>1,024</td>
</tr>
<tr>
<td>ROC (Raid-on-Chip)</td>
<td>LSISAS2208 dual-core PowerPC</td>
</tr>
</tbody>
</table>

### Internal storage

#### OS HDDs
- **Vendor and model number**: Dell ST9300605SS
- **Number of drives**: 2
- **Speed (Gbps)**: 6
- **Size (GB)**: 300
- **RPM**: 10K
- **Type**: SAS

#### Data HDDs
- **Vendor and model number**: Dell ST9146852SS
- **Number of drives**: 8
- **Speed (Gbps)**: 6
- **Size (GB)**: 146
- **RPM**: 15K
- **Type**: SAS

#### CacheCade SSDs
- **Vendor and model number**: Dell Pliant Lightning X1MCH
- **Number of drives**: 2
- **Speed (Gbps)**: 3
- **Size (GB)**: 149
- **RPM**: N/A
- **Type**: SSD

#### Data SSDs
- **Vendor and model number**: Dell Pliant Lightning X1MCH
- **Number of drives**: 4
- **Speed (Gbps)**: 3
- **Size (GB)**: 149
- **RPM**: N/A
- **Type**: SSD

*Figure 6: Test storage configuration information.*
APPENDIX C – SETTING UP THE STORAGE

Dell PowerEdge R720 configuration overview

We configured the Dell PowerEdge R710 to run ESXi 5.0 from internal SD cards. For the operating system and log files for each VM, we used two 300GB 10K SAS drives in a RAID 1 volume. For the data volumes, we used multiple drive configurations as follows:

- Six 146GB, 15K, 6Gbps SAS hard disk drives for all data volumes (HDD solution)
- Six 146GB, 15K, 6Gbps SAS hard disk drives for all data volumes with two 149GB, 3Gbps SAS solid state drives in a CacheCade pool (CacheCade solution)
- Eight 146GB, 15K, 6Gbps SAS hard disk drives for Exchange and SharePoint data volumes, and four 149GB, 3Gbps solid state drives for SQL Server volumes (Hybrid solution)

Setting up the internal storage for host operating system installation

1. Enter the RAID controller BIOS by pressing Ctrl+R at the relevant prompt during boot.
2. Highlight the controller and press F2.
3. Select Create New VD.
4. Select the first two drives, select RAID level 1, tab to the OK button, and press Enter. Accept the warning regarding initialization.
5. Select the new virtual drive, press F2, and select Initialization, Start Init.
6. Wait for the initialization operation to complete.
7. Repeat steps 2 through 6 for the remaining internal volume using RAID level 10 and selecting the remaining drives. Note: For the CacheCade configuration, you will also need to create the CacheCade pool at this point.
8. Press Escape, and choose to Save and Exit to return to the boot sequence.
Adjusting BIOS settings

We used the latest released BIOS updates on the Dell PowerEdge R720 and verified that Virtualization Technology was enabled. ESXi came pre-loaded on the Dell PowerEdge R720. To enable this, we set the boot mode to the SD card. Following the ESXi installation, we used vCenter to update the server to the latest build available (Version 515841).

Setting up vSphere Client on a utility client

We set up a test client running Windows Server 2008 R2 SP1 and performed the following steps to install vSphere Client:

1. Insert the vCenter Server 5 DVD.
2. Select Autorun.
3. Select vSphere Client from the list of VMware Product Installers, and click Install.
4. Select English, and click OK.
5. At the Welcome screen, click Next.
6. Click Next to accept the End-User Patent Agreement.
7. Accept the License Agreement, and click Next.
8. Enter the User Name and Organization information, and click Next.
9. Accept the default destination folders, and click Next.
10. At the Ready to Install screen, click Install.
11. When the installation completes, click Finish.
12. Connect to the Dell PowerEdge R720 using vSphere client.

Configuring ESXi after installation

1. On the 5.0.0 ESXi screen, press F2, enter the root password, and press Enter.
2. On the System Customization screen, select Troubleshooting Options, and press Enter.
3. On the Troubleshooting Mode Options screen, select enable ESXi Shell, and press Enter.
4. Select Enable SSH, press Enter, and press ESC.
5. On the System Customization screen, select Configure Management Network.
7. On the IP Configuration screen, select set static IP, enter an IP address, subnet mask, and default gateway, and press Enter.
8. On the Configure Management Network screen, press Esc. When asked if you want to apply the changes, press Y.

Configuring VM networking on ESXi

1. Using the vSphere client from another machine, connect to the ESXi server.
2. Remove the default created VM Network from the NIC assigned to the Management Network:
   a. Click the host, click the Configuration tab, and click Networking.
   b. Under Standard Switch: vSwitch0, click Properties...
   c. Select VM Network, and click Remove.
   d. When prompted to confirm the removal, click Yes.
   e. Click Close.
3. Add a new VM Network vSwitch:
   a. Click the host, click the Configuration tab, and click Networking.
   b. Click Add Networking.
   c. Choose Virtual Machine, and click Next.
   d. Choose create a vSphere standard switch, select vmnic1, vmnic2, vmnic3, and click Next.
Configuring the storage volumes in VMware vSphere 5.0
1. In the vSphere client, select the host.
2. Click the Configuration tab.
3. Click Storage, and click Add Storage...
4. Choose Disk/LUN.
5. Select the first disk, and click Next.
6. Accept the default of VMFS-5 for the file system.
7. Review the disk layout, and click Next.
8. Enter VM OS for the datastore name, and click Next.
9. Accept the default of using maximum capacity, and click Next.
10. Click Finish.
11. Repeat steps 3 through 10 for the remaining LUN(s), and enter VM Data (and VM SSD Data in the Hybrid configuration) for the datastore name.

Creating the VMs
1. In the vSphere client, connect to the vCenter Server, and browse to the ESXi host.
2. Click the Virtual Machines tab.
4. Choose Custom, and click Next.
5. Assign a name to the virtual machine, and click Next.
6. Select the VM OS datastore in storage, and click Next.
7. Choose Virtual Machine Version 8, and click Next.
8. Choose Windows, and choose Microsoft Windows Server 2008 R2 (64-bit), and click Next.
9. Choose 8 virtual sockets for the first VM, and click Next. Note: Select 4 virtual sockets for the second VM and 4 virtual sockets for the third VM.
10. Choose 8 GB RAM, and click Next. Note: Select 6 GB RAM for the second VM and 4 GB RAM for the third VM.
11. Leave 1 for the number of NICs, select vmxnet3, and click Next.
12. Leave the default virtual storage controller, and click Next.
13. Make the OS virtual disk size 40 GB, choose thick-provisioned lazy zeroed, specify the OS datastore on the storage, and click Next.
14. Keep the default virtual device node (0:0), and click Next.
15. Click Finish.
16. Repeat steps 1-16 twice for the remaining two VMs.

Creating the additional virtual disks
For the first VM, we created a 10GB virtual disk for SQL log files on the VM OS datastore, and a 25GB virtual disk for the SQL database. This SQL database virtual disk is located on the VM Data datastore for the HDD and CacheCade configurations, and on the VM SSD Data datastore for the Hybrid configuration. For the second VM, we created a 370GB virtual disk for the Exchange database on the VM Data datastore, and an additional 10GB virtual disk for Exchange logs on the VM OS datastore. For the third VM, we created a 10GB virtual disk for SharePoint on the VM Data datastore.

Complete these steps to create each additional virtual disk.
1. In the vSphere client, connect to the vCenter Server, and browse to the ESXi host.
2. Right-click the appropriate VM, and choose Edit Settings.
3. On the Hardware tab, click Add...
4. Click Hard Disk, and click Next.
5. Click Create a new virtual disk, and click Next.
6. Specify the virtual disk size, choose thick-provisioned lazy zeroed, specify the appropriate datastore for Location, and click Next.
7. Choose a device node, and click Next.
8. Click Finish.
9. Click OK.
APPENDIX E – CONFIGURING THE VMS, ACTIVE DIRECTORY, AND TEST CLIENTS

See the previous appendices regarding the initial creation of the virtual machines on each hypervisor. In this section, we provide steps for installing the operating system, Microsoft SQL Server, Microsoft Exchange Server, Microsoft SharePoint Server, and configuration of the VMs.

Installing the VM operating system

1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive, and attach the physical DVD drive to the VM. Alternatively, use an ISO image and connect to the ISO image from the VM console.
2. Open the VM console on vSphere.
3. At the Language Selection Screen, click Next.
4. Click Install Now.
5. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
6. Click the I accept the license terms checkbox, and click Next.
7. Click Custom.
8. Click Next.
9. At the User’s password must be changed before logging on warning screen, click OK.
10. Enter the desired password for the administrator in both fields, and click the arrow to continue.
11. At the Your password has been changed screen, click OK.
12. Install the latest VMware tools package on the VM in the console screen:
   a. Click VM →Guest→ Install/Upgrade VMware Tools.
   b. Click OK to confirm.
   c. Click Run setup64.exe in the AutoPlay screen.
   d. Click Next.
   e. At the Setup Type, leave Typical selected, and click Next.
   f. Click Install.
   g. Click Finish.
   h. Click Yes to restart the VM.
13. Connect the machine to the Internet, and install all available Windows updates. Restart as necessary.
14. Enable remote desktop access.
15. Change the hostname and reboot when prompted.
16. Set up networking:
   a. Click Start→Control Panel, right-click Network Connections, and choose Open.
   b. Right-click the VM traffic NIC, and choose Properties.
   c. Select TCP/IP (v4), and choose Properties.
   d. Set the IP address, subnet, gateway, and DNS server for the virtual NIC, which will handle outgoing server traffic. Click OK, and click Close.
17. In the VM, configure the VM storage:
   a. Click the Server Manager icon in the taskbar.
   b. In the left pane, expand Storage, and click Disk Management.
   c. Right-click the first volume, and choose Initialize Disk.
   d. In the right pane, right-click the volume and choose New Simple Volume...
   e. At the Welcome screen, click Next.
   f. At the Specify Volume Size screen, leave the default selection, and click Next.
   g. At the Assign Drive Letter or Path screen, choose a drive letter, and click Next.
h. At the Format Partition screen, choose NTFS and 64K allocation unit size, and click Next.
i. At the Completing the New Simple Volume Wizard screen, click Finish.
j. Repeat steps c through i for the remaining VM volumes.
18. Repeat steps 1-17 twice more for the remaining two VMs.

Setting up the domain controller

We set up a separate machine for our domain controller by installing a fresh copy of Windows Server 2008 R2 SP1 Enterprise Edition with updates, and installing the Active Directory Domain Services and DNS server roles.

1. Set a static IP address:
   a. Right-click the network icon in the quick-launch bar, and choose Network and Sharing Center.
   b. Click Manage network connections.
   c. Right-click the local area connection, and choose Properties.
   d. Select Internet Protocol Version (TCP/IPv4), and click Properties.
   e. Select the Use the following IP address radio button, and type 192.168.1.1 in the IP address field.
   f. Press Tab to auto-fill 255.255.255.0 in the Subnet mask field.
   g. Click Close.
2. Give the system a name:
   a. Click Start, right-click Computer, and select Properties.
   b. Click Change Settings.
   c. Click Change.
   d. Type ADSERVER in the Computer name field, and click OK.
   e. In the Computer Name/Domain Changes pop-up window, click OK.
   f. Click OK.
   g. In the Microsoft pop-up window, click Restart Now.
3. Promote the mail server to domain controller:
   a. Select Start→Command Prompt.
   b. Type dcpromo
   c. At the Welcome pop-up window, click Next.
   d. At the Operating System Compatibility screen, click Next.
   e. At the Choose a Deployment Configuration screen, select the Create a new domain in a new forest radio button, and click Next.
   f. At the Name the Forest Root Domain screen, type the domain name test.local and click Next.
   g. At the Set Forest Functional Level screen, choose Windows Server 2008 R2 from the drop-down menu, and click Next.
   h. At the Set Domain Functional Level screen, choose Windows Server 2008 R2 from the drop-down menu, and click Next.
   i. At the Additional Domain Controller Options screen, accept the defaults, and click Next.
   j. When the Active Directory domain Services Installation Wizard screen pops up, click Yes.
   k. At the Location for Database, Log Files, and SYSVOL screen, click Next.
   l. At the Directory Services Restore Mode Administrator Password screen, enter a password, and click Next.
   m. At the Summary screen, review the selections, and click Next.
   n. At the Completing the Active Directory Installation Wizard screen, click Finish.
   o. When the system prompts you to reboot the server, click Restart Now.
   p. After the server reboots, log into the system.

Creating the tester user

1. Select Start→All Programs→Administrative Tools→Active Directory Users and Computers.
2. In the Active Directory Users and Computers screen, select the server in the left pane, and open Users in the right pane.
3. Right-click a blank area in the Users folder, and select New → User.
4. In the New Object - User screen, complete the name fields as you wish (we used first name: test, last name: tester, logon name: tester), and select Next.
5. Enter a secure password (we used Password1), and check Password never expires.
6. In the pop-up information screen, click Accept.
7. Select Next to close the New Object – User screen.
8. Double-click the new user to bring up the Properties screen.
9. Under the Member Of tab, click Add.
10. In the Enter the object names to select dialog box, type the following:
    Domain Admins; Enterprise Admins; Organization Management
    Then, select Check Names to verify, and click OK.
11. Click OK to close the User Properties screen, and close the Active Directory Users and Computers screen.

**Configuring VM #1**

**Installing Microsoft SQL Server 2008 R2**

1. Insert the installation DVD, and capture the DVD drive in the VM session.
2. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2008 R2 DVD, and double-click.
3. If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
4. In the left pane, click Installation.
5. Click New installation or add features to an existing installation.
6. At the Setup Support Rules screen, wait for the check to complete. If there are no failures or relevant warnings, click OK.
7. Select the Specify a free edition and select Evaluation from the drop-down menu. Click Next.
8. Click the checkbox to accept the license terms, and click Next.
9. Click Install to install the setup support files.
10. If no failures are displayed, click Next.
11. At the Setup Role screen, choose SQL Server Feature Installation.
13. At the Installation Rules screen, click Next once the check completes.
14. At the Instance configuration screen, leave the default selection of default instance, and click Next.
15. At the Disk space requirements screen, click Next.
16. At the Server configuration screen, choose NT AUTHORITY\SYSTEM for SQL Server Agent, and choose NT AUTHORITY\SYSTEM for SQL Server Database Engine. Click Next.
17. At the Database Engine Configuration screen, select Mixed Mode.
18. Enter and confirm a password for the system administrator account.
19. Click Add Current user. This may take several seconds.
20. Click Next.
21. At the Error and usage reporting screen, click Next.
22. At the Installation Configuration rules screen, check that there are no failures or relevant warnings, and click Next.
23. At the Ready to Install screen, click Install.
25. Click Close.
26. Click Start → All Programs → Microsoft SQL Server 2008 R2 → Configuration Tools, and click SQL Server Configuration Manager
27. Expand SQL Server Network Configuration, and click Protocols for MSSQLSERVER.
28. Right-click TCP/IP, and select Enable.

Creating a blank database
1. Click Start→All Programs→Microsoft SQL Server 2008 R2→SQL Server Management Studio.
2. Log into the default instance using the appropriate credentials.
3. Right-click Databases and select New Database.
4. Enter Testdb for the database name.
5. Set the Initial Size of the data file to 20,480 MB, and the log file size to 8,192 MB.
6. Change the path of the data file by clicking ..., select E:\SQLData, and click OK. Repeat for the log file and select F:\SQLLog.
7. Click OK to begin the database creation.

Configuring VM #2
Installing .NET Framework 3.5.1 Features and Internet Information Services
1. Select Start→Administrative Tools→Server Manager.
2. Click Features.
3. Click Add Features.
4. Select .NET Framework 3.5.1 Features
5. Click Add Required Role Services.
6. Click Next.
7. Click Next.
8. At the Select Role Services screen, select the IIS 6 Metabase Compatibility, IIS 6 Management Console, Basic Authentication, Windows Authentication, Digest Authentication, Static content compression, and Dynamic content Compression checkboxes, and click Next.
9. At the Confirm Installation Selections screen, click Install.
10. At the Installation Results screen, click Close.

Installing Microsoft Filter Pack 2.0
1. Download the Microsoft Filter Pack 2.0.
2. Run FilterPackx64.EXE.
3. Click Next.
4. Click I accept the terms in the License Agreement, and click Next.
5. When the installation is complete, click OK.

Installing Exchange Server 2010
1. Click Start, type services and press Enter.
2. Right-click the Net.Tcp Port Sharing service, and click Properties.
3. Change the Net.Tcp Port Sharing startup type to Automatic, and click OK.
4. Open command prompt and type ServerManagerCmd -i RSAT-ADDS, and press Enter.
5. Reboot the VM.
6. Insert the installation DVD, capture the host DVD drive to VM2 and click Setup.EXE when prompted.
7. The installer should consider steps 1 and 2 complete, and gray them out.
8. Click the link for Step 3: Choose Exchange Language Option.
9. Click Install only languages from the DVD.
10. Click the link for Step 4: Install Microsoft Exchange Server 2010 SP1.
11. Click Next to go past the introduction screen.
12. Accept the license agreement, and click Next.
13. Select No for error reporting, and click Next.
15. Leave the organization name at default (First Organization), and click Next.
16. At the question about client computers running Outlook 2003 and earlier, select Yes, and click Next.
17. Click Next to accept defaults for Configure Client Access server external domain.
18. At the Customer Experience Improvement Program screen, select I don’t want to join the program at this time, and click Next.
19. If a warning about a lack of SMTP appears after the check finishes, ignore it.
20. Click Install to start the installation process.
21. Once installation is complete, click Finish.
22. Click OK when prompted to reboot.
23. Click Close.
24. Click Yes to confirm exit.
25. Reboot the VM.

Configuring Exchange Server 2010 roles
2. In the left pane, click Microsoft Exchange On-Premises.
3. In the left pane, expand Organization Configuration, and select Hub Transport.
4. In the action pane on the far right, select New Send Connector.
5. Name the send connector SMTP, select the intended use as Internet, and click Next.
6. In the Address space screen, click Add.
7. In the SMTP Address Space screen, type * as the address, ensure that the installer has checked Include all subdomains, and click OK.
8. Click Next.
9. Accept defaults for the next two pages by clicking Next.
10. At the New Connector page, click New to create the connector.
11. Click Finish to close the New SMTP Send Connector wizard.

Configuring the Exchange Server 2010 Mailbox role
2. In the left pane of the Exchange Management Console screen, select Recipient Configuration; in the right pane, select New Mailbox.
3. In the New Mailbox screen, select User Mailbox, and click Next.
4. In the User Type page, select Existing users, and click Add.
5. Select the new account you created earlier, and click OK to add it to the selection box.
6. Click Next.
7. In the Mailbox Settings screen, type tester in the Alias textbox, check the box beside Specify the mailbox database rather than using a database automatically selected, and select Browse in the Mailbox database selection.
8. In the Select Mailbox database screen, select Mailbox Database, and click OK.
9. Click Next.
10. Click New.
11. Click Finish.
12. In the left pane, expand Organization Configuration, and click Mailbox.
13. Click the Database Management tab.
15. Select the Maintenance tab.
16. Check the Enable circular logging box.
17. Check the box beside This database can be overwritten by a restore.
18. Next to Maintenance interval, click Customize.
19. Remove all blue from the boxes so the system will not perform maintenance, and click OK.
20. Click OK.
21. Click OK to any warnings about circular logging being applied after the database is remounted.
22. On the far right panel, click Move Databases.
23. Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Maillogs respectively, and click Move.
24. If the application prompts you to dismount, click Yes.
25. Click Finish.
26. Right-click Public Folder Database, and select Properties.
27. Check the Enable circular logging checkbox.
28. Check the This database can be overwritten by a restore checkbox.
29. Click Customize next to Maintenance interval.
30. Remove all blue from the boxes so the system will not perform maintenance, and click OK.
31. Click OK.
32. On any warnings about circular logging being applied after the database is remounted, click OK.
33. Click Move Database on the far right panel.
34. Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Publiclogs respectively, and click Move.
35. If the application prompts you to dismount, click Yes.
36. Click Finish.

**Configuring VM #3**

**Installing SharePoint Server 2010**

1. Insert the installation DVD, and capture the DVD drive in the VM session.
2. Launch splash.hta, and click Install software prerequisites.
3. At the Welcome to the Microsoft SharePoint 2010 Products Preparation Tool screen, click Next.
4. Accept the EULA, and click Next.
5. When the prerequisites finish installing, click Finish.
6. On the main SharePoint installation menu, click Install SharePoint Server.
7. Enter your product license key, and click Continue.
8. Accept the EULA, and click Continue.
9. Choose the Stand-Alone server type, and click Install.
10. When the installation finishes, check the box for Run the SharePoint Products Configuration Wizard now, and click Close.
11. On the Welcome to SharePoint Products screen, click Next.
12. On the pop-up warning about services that will need to be restarted during the configuration, click Yes.
13. When the wizard has completed the configuration, click Finish.

**Preparing the Benchmark Factory client**

We completed the following steps on a separate desktop client.

**Installing Windows Server 2008 R2 SP1**

1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.
2. At the Language Selection Screen, click Next.
3. Click Install Now.
4. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Click the I accept the license terms checkbox, and click Next.
6. Click Custom.
1. Insert the SQL Server 2008 disk.
2. If prompted, click OK to enable the .NET Framework Core role.
3. In the left pane, click Installation.
4. Select New SQL Server Stand-alone installation or Add features to existing installation.
5. On the Setup Support Rules screen, click OK.
6. On the Setup Support Files screen, click Next.
7. On the Installation Type screen, click Next.
8. On the Product Key screen, click Next.
9. At the License agreements screen, click Next.
11. On the Error and Usage Reporting screen, click Next.
13. On the Ready to Install screen, click Install.

Installing Benchmark Factory 6.6.1

1. Double-click the exe to start the installation.
2. At the Welcome to the installer screen, click Next.
3. At the License Agreement, select I accept the terms, and click Next.
4. On the Destination Screen, select Next.
5. On the Ready to install program screen, select Yes install the default repository database, and click Install.
6. Click Start→All Programs→Quest Software→Benchmark Factory for Databases(64-bit)→Benchmark Factory for Databases.
7. When the Load Scenario Wizard screen pops up, click Next.
8. At the Select Load Scenario screen, select Industry standard benchmarks (TPC-C, TPC-E, TPC-H...), and click Next.
9. At the Select Benchmark screen, select TPC-E, and click Next.
10. At the Select Profile screen, click New.
11. Click Next.
12. At the Driver Selection screen, select Microsoft SQL Server (ODBC) from the drop-down menu, and click Next.
13. At the Connection Information, click Add DSN.
14. Select System Data Source, and click Next.
15. Select SQL Server Native Client 10.0, and click Next.
16. Enter Test for the file data source, and click Next.
17. Click Finish.
18. For Which SQL Server do you want to connect to? enter SQLServer.test.local and click Next.
19. For How should SQL Server verify the authenticity of the login ID? select With SQL Server authentication using a login ID and password entered by the user, enter sa for the Login ID and Password1 for the password, and click Next.
20. At the next screen, check the Change the default database to checkbox and select Testdb from the drop-down menu. Click Next.
21. Click Finish.
22. Click Test Data Source...
23. Click OK.
24. Click OK.
25. Click Next.
26. Enter Test for the Profile Name.
27. Click Finish.
28. At the Select Profile screen, click Next.
29. At the Benchmark Scale screen, change Benchmark Scale to 2 and click Next.
30. At the Measurement Intervals screen, click Delete All to remove the default selected user loads, enter 100 under Add Single User Load, and click Add. Click Next.
31. At the Enter Script Name, select Create a new Benchmark Factory Script file, enter TPC-E, and click Next.
32. At the next screen, uncheck the box beside Do you want the job to be automatically submitted to the jobs Queue? and click Finish.
33. Right-click the newly created job, and click Copy.
34. Right-click TPC-E above the job, and click Paste. You should see identical copies of the newly created job. Rename the first to TPC-E Job – Create, and the second to TPC-E Job – Test
35. On TPC-E Job - Create, right-click TPC-E Transaction Mix, and click Remove. Click Yes to confirm.
36. On TPC-E Job – Test, right-click Create Objects for TPC-E, and click Remove. Click Yes to confirm.
37. Right-click TPC-E Job – Create, and click Submit Job.
38. Click Submit.

Installing and configuring the Exchange 2010 mail test client (LoadGen)

To create the mail client, you must install several software components. Before following these instructions, make sure to statically assign an IP address for the client, and to then plug that port into the system under test. This allows the client to join the Active Directory domain. We followed this process for each installation:

Installing Windows Server 2008 R2 SP1 Enterprise Edition
1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.
2. At the Language Selection Screen, click Next.
3. Click Install Now.
4. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
5. Click the I accept the license terms checkbox, and click Next.
6. Click Custom.
7. Click Next.
8. At the User’s password must be changed before logging on warning screen, click OK.
9. Enter the desired password for the administrator in both fields, and click the arrow to continue.
10. At the Your password has been changed screen, click OK.
11. Click Start, type change power-saving settings and press Enter.
12. Click Change plan settings.
13. Change the Turn off the display drop-down menu to Never.
14. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization screens.

To set up this server, we had to install several additional software components. The following subsections detail the necessary installation processes.
Joining the domain
1. Select Start  Control Panel  Network Connections  Local Area Connection.
2. Click Properties.
3. Highlight Internet Protocol (TCP/IP), and click Properties.
4. Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the Preferred DNS server field. Click OK.
5. Right-click My Computer, and select Properties.
6. Under the Computer Name tab, click Change.
7. In the Computer Name Changes screen, under the Member of section, select the Domain radial box, and type test.local
8. Select OK to start joining the domain.
9. When the screen appears asking for a person qualified on the domain, type Tester as the username and Password1 as the password.
10. At the Welcome pop-up window and the window warning that you must reset the computer for the changes to take effect, click OK.
11. At the System Properties screen, click OK.
12. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services
1. Click Start  Administrative Tools  Server Manager.
2. On the left pane, click Roles.
3. Click Add Roles.
4. Click the Application Server checkbox.
5. When the Add features required for Application Server? screen appears, click Add Required Features.
6. Click Next.
7. At the Select Role Services page for Application Server, click the Web Server (IIS) Support checkbox.
8. Click Add Required Support Role Services.
9. Click Next.
10. Click Next.
11. At the Select Role Services page for Web Server (IIS), click IIS 6 Management Compatibility, ASP, and CGI checkboxes; and click Next.
12. Click Install.
13. Click Close.

Installing Load Generator
Download and install Load Generator using all defaults.

Preparing Load Generator
1. Log into the mail client using the tester account.
2. Select Start  All Programs  Microsoft Exchange  Exchange Load Generator 2010.
3. When the Load Generator screen appears, select Start a new test.
4. Select Create a new test configuration, and click Continue.
5. Change the total length of simulation to 32 minutes.
6. Verify that the account name is tester.
7. In the Specify test settings screen, type Password1 as the Directory Access Password and Mailbox Account Master Password, and click Continue with recipient management.
8. Make 500 users in the Mailbox Database, and click Continue.
9. To accept defaults for Advanced recipient settings, click Continue.
10. In the Specify test user groups screen, select the plus sign to add a user group.
11. Change the Client Type to Outlook 2007 Cached, the Action Profile to Average, and the Mailbox size to 100 MB.
12. Check the PreTestLogon checkbox, and click Continue.
13. Leave defaults in Remote configurations, and click Continue.
14. Click Save the configuration file as, and name it 600users-averagecfg.xml.
15. After saving the configuration file, check the Initialize public store as well checkbox, and click Start the initialization phase (recommended before running the test).

**Backing up the mail database**

On the Exchange server virtual machine, once you have set up the LoadGen client and created its initial mail database, you need to back up that database so you can have clean copies for each test.

1. Select Start ➔ All Programs ➔ Microsoft Exchange Server 2010 ➔ Exchange Management Console in the mail server.
2. In the left pane, expand Organization Configuration and Mailbox.
3. In the right pane, right-click Mailbox Database, and select Dismount Database from the menu.
4. At the Do you want to continue? pop-up message, click Yes.
5. Right-click Public Folder Database, and select Dismount Database from the menu.
6. At the Do you want to continue? pop-up message, click Yes. The red arrow appears when you have dismounted the Public Folder Store.
7. Using Windows Explorer, create a new folder: E:\backup\.
8. With Windows Explorer, copy all database and public folder files from E:\Database to E:\backup. This process may take several minutes.
10. In the Exchange Management Console, right-click Mailbox Database, and select Mount Database from the menu.
11. Right-click the Public Folder Database, and select Mount Database from the menu.

**Preparing the SharePoint test client**

Install Windows Server 2008 SP1 with current updates.

**Installing Microsoft Visual Studio 2010 Ultimate Edition**

2. Double-click vs_ultimateweb.exe to run the installer.
3. Uncheck the box beside Yes, send information about my computer, and click Next.
4. If you see a pop-up requiring a Windows Imaging component, click the Windows Imaging Component is Required link.
5. Click Download on the appropriate Imaging component, and choose Run.
6. Accept the EULA, and click Next.
7. Close the pop-up window.
8. Click Next.
9. Accept the EULA, review the components to be installed, and click Next.
10. Choose the Full installation and location for the install, and click Install.
11. Click Finish.
12. Reboot the machine.

**Setting up and running WSSDW 1.0.0.0 Beta**

1. Complete the following steps on the Domain Controller machine:
3. Complete the following steps on the SharePoint 2010 VM:
   b. Copy the contents of both extracted .zip folders (WSS Data Population Tool Run Time and WSS Data Population Tool Sample) into the root of C:\
   c. Right-click on a blank space in C:\ select New, click Text Document and name it data.txt. Ensure that this is in the root of C: \
   d. Rename WSS Data Population Sample File.xml to WSS_Data_Population_Sample_File.xml so that there are no spaces in the name. This will allow for execution of the script from the command prompt.
   e. Right-click WSS_Data_Population_Sample_File.xml and click Edit to open the document in Notepad. Change any applicable parameters to match the following:

   ```xml
   <setproperty NumberOfSiteCollections="100" />
   <setproperty SiteNameBase="testsite" />
   <setproperty NumberOfGroups="2" />
   <setproperty GroupNameBase="testgroup" />
   <setproperty TargetDomain="test.local" />
   <setproperty DomainGroupRoot="testdomaingroup" />
   <setproperty DomainUserName="administrator" />
   <setproperty DomainUserPassword="Password1" />
   <setproperty DesignerGroup="design" AdminGroup="full control" />
   <setproperty NumberOfDocumentLibraries="5" />
   <setproperty DocumentLibraryNameBase1="testdoclib_A" />
   <setproperty NumberOfDocuments="10" />
   <setproperty SourceFileLocation="c:\data.txt" />
   <setproperty DestFile="test" />
   <setproperty NumberOfFileVersions="3" />
   <setproperty DocumentLibraryNameBase2="testdoclib_B" />
   <setproperty NumberOfLists="10" />
   <setproperty ListNameBase="testlist" />
   <setproperty NumberOfListItems="20" />
   <setproperty webpartpath="webpartpagesfolder" />
   
   f. Open the command prompt and execute the script:

   C:\>WSSDW.exe WSS_Data_Population_Sample_File.xml
   
4. Complete the following steps on the SharePoint 2010 test client
a. Extract the contents of WSS Performance Load Test to C: drive on the SharePoint test client.
b. On the SharePoint test client, open the WssTransactions folder, then right-click→Edit and modify the following files as follows:
   • users.csv
     Under username, password enter test.local\administrator, Password1 and remove the remaining entries.
   • serverUrl.csv
     Under serverUrl replace http://server with http://spserver to match the server name of the SharePoint 2010 VM
   • HierarchyManagerUsers.csv
     Under username, password replace domain\username, password with test.local\administrator,Password1
c. Open the WssTestProject.sln file in Visual Studio 2010 Ultimate.
d. When prompted, click Next.
e. Click Finish.
f. When prompted, leave the Retarget the project to .NET Framework 4. After the project opens, you can retarget it to another Framework or Profile radio button selected and click OK.
g. Click Close.
h. In the Solution Explorer pane, scroll to WSSDispForm, and double-click it.
i. Expand the top menu under WSSDispForm in the left pane, expand Validation rules, and delete the FindText entry that references mysite.aspx.
j. Click Save.
k. Repeat steps f through h for WSSHomePage and WSSSmallDocLibAllItems.
l. Click Project→Add Load Test.
m. At the Welcome to the Create New Load Test Wizard, click Next.
n. Enter Test for the load test scenario name, change the think time between test iterations to 45 seconds, and click Next.
o. At the Load pattern settings for a load test scenario screen, select Constant load, enter 125 for the User Count, and click Next.
p. Click Next at the Select a test mix model for the load test.
q. At the Add test to a load test scenario and edit the test mix, click Add and select the following:
   • WSSDispForm
   • WSSDocHTTPFetch
   • WSSHomePage
r. WSSSmallDocLibAllItems
   Click OK.
s. Ensure that the distribution is set to 25%, and click Next.
t. At the network types screen, select LAN, and click Next.
u. At the Browser screen, click Next.
v. At the Specify computers to monitor with counters sets during load test run screen, click Next.
w. At the Review and edit run settings for load test, enter 1 minute for the Warm-up duration, enter 30 minutes for Run duration, and click Finish.
x. Click Run test to start the test.
We provide industry-leading technology assessment and fact-based marketing services. We bring to every assignment extensive experience with and expertise in all aspects of technology testing and analysis, from researching new technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We provide our clients with the materials they need, from market-focused data to use in their own collateral to custom sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients’ individual requirements. Whether the technology involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help our clients assess how it will fare against its competition, its performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20 years. As journalists, they published over a thousand articles on a wide array of technology subjects. They created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company by Lionbridge Technologies were the head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc. All other product names are the trademarks of their respective owners. CacheCade is a trademark of LSI Corp.

Disclaimer of Warranties; Limitation of Liability:
PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.